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Правила и алгоритми за опроводяване на платка 

(ръчно или автоматично) 
 
1. Подготовка на платката за опроводяване 

- Определяне на слоевете, предназначени за опроводяване на сигналите и 
захранващи слоеве; 
- Дефиниране на проходни отвори – ако са дефинирани мрежи с по-голяма 
широчина трябва да се дефинират подходящи проходни отвори и да се присъединят 
към съответната мрежа; 
- Установяване и проверка на свойствата на мрежите (задаване на по-голяма 
широчина на VCC и GND); 
- Проверка за нарушени разстояния при разполагане на компонентите. 

2. Етапи на процеса на опроводяване 
2.1. Извършване на следните проверки 

- Очертания на платката; 
- Дефиниране на проходни отвори и слоеве; 
- Свойства на мрежите; 
- Нарушени разстояния между компонентите. 

2.2. Зареждане на файл стратегия за опроводяване 
Файлът стратегия за опроводяване определя: 

- Слоя за опроводяване по подразбиране; 
- Кога се поставят проходни отвори; 
- Цветове за опроводяване; 
- Посока на пистите; 
- Размер на активния прозорец. 

Команда:  File => Load – избор на подходяща стратегия за опроводяване с <име>.sf от 
директория DATA. 
2.3. Опроводяване на мрежите „захранване” и „земя” 

Основен принцип при опроводяването на платка - най-напред се 
опроводяват захранващите мрежи. 
2.3.1. Опроводяване на захранващите мрежи на многослойни платки с нормален 
монтаж 

При платки за нормален монтаж съответните захранващи мрежи се свързват към плоскостните  
(Plane) слоевете автоматично, като се поставят петна за подобряване на топлоотдаването 
(thermal reliefs). 
2.3.2. Опроводяване на захранващите мрежи на многослойни платки с повърхностен 
монтаж 

За платки с повърхностен монтаж на компонентите е необходимо да се реализира връзка 
между петната на SMT елемента и другите вътрешни слоеве включително и Plane слоевете. 

А) Метод за опроводяване на петна за повърхностен монтаж  

Fanout process – процес на присъединяване на петната за повърхностен монтаж към 
вътрешните слоеве на платката,  включително и Plane слоевете. Реализира се със специални 
проходни отвори за опроводяване на петна за повърхностен монтаж, както е показано на Фиг. 1. 

Fanout Via  - специални проходни отвори за реализиране на процеса на опроводяване на 
петната за повърхностен монтаж на вътрешните слоеве на платката. 

За осъществяване на опроводяването на захранващите мрежи на схемите за повърхностен 
монтаж е необходимо тези мрежи да бъдат присвоени към захранващите слоеве. Преди 
опроводяването на тези мрежи трябва да се забрани опроводяването на всички останали 
сигнални проводници.  



На Фиг. 2 е демонстриран резултатът от изпълнението на Fanout process за захранващите 
мрежи при опроводяване на четирислойна платка. 

  

Фиг. 1. Опроводяване на петна за повърхностен монтаж (Fanout process) 

 

Фиг. 2. Опроводяване на мрежите захранване и земя на схеми за повърхностен монтаж 

Б) Алгоритъм за автоматичен Fanout 
· конфигуриране на параметрите на процеса с команда Options Fanout 
Settings(Фиг.3);  
· в диалоговия прозорец Fanout Settings избор на подходящи опции и проходен 
отвор; 
· Избор на команда Auto => Fanout => Board. 



 

Фиг. 3. Диалогов прозорец Fanout Settings 

Б) Алгоритъм за ръчен Fanout 

· Избор на бутон за ръчно опроводяване Add/Edit Route Mode; 
· Избор на петно от  мрежа VCC или GND; 
· Опроводяване на мрежата до логическата точка (vertex), в която трябва да се 
постави проходен отвор Fanout via; 
· Клик на ляв бутон на мишката или бутон Spacebar за поставяне на логическа точка; 
· Поставяне на проходен отвор с команда Add via или Add Free via. 

2.3.3. Диалогов прозорец за редактиране на мрежи Edit Net  
Командата за отваряне на електронната таблица за мрежи е View Spreadsheet Toolbar 

button => Nets => избира се мрежа и на pop-up меню Properties. Отваря се диалоговият 
прозорец Edit Net. 
 Полета на диалоговия прозорец Edit Net са показани на Фиг. 4:  

- Поле Net Name – име на мрежата, при избрани повече от една мрежи е неактивно. 
- Поле Net Attributes: 
· Опция Routing Enabled – „разрешена за опроводяване”, ръчно или автоматично 
опроводяване само, ако е избрана. По подразбиране е активна. 
· Опция Retry Enabled – позволява преопроводяване на избрана писта за да се 
осигури празно пространство за друга писта. По подразбиране е активна. 



· Опция Share Enabled – позволява опроводена писта в дадена мрежа да се 
разглежда като разрешена точка на връзка за всяка нова писта в същата мрежа т.е. 
разрешена е т.нар „T връзка”  (“T connection”). Ако опцията е забранена 
автоматичният трасировчик може да свързва с писта само петна. 
· Опция Shove Enabled – позволява да се избутва дадена писта с цел да се 
освободи пространство за опроводяването на друга писта. Ако е необходимо пистата 
да е блокирана напълно, трябва да се изключат Shove и Retry Enabled. Използването 
на тези опции е равностойно на изпълнение на команда Lock. 
· Опция Highlight – „осветеност” - по-ярък цвят на пистата с цел по-лесно 
проследяване. 
· Опция Test Point – мрежата ще е присъединена към тестова точка (команда 
Autoplace Test Point) 

 

 

Фиг. 4. Диалогов прозорец Edit Net 

- Поле Group – на ниво схематика може да се присвои номер на група от мрежи, 
който се въвежда в полето Group. Мрежата от връзки на групираните мрежи са в един 
цвят. Всички мрежи, които не са присвоени към група, са в жълт цвят и принадлежат 
към група „0”.  
- Поле Weight – дефинира се тегло на мрежата в линеен мащаб от 0 до 100, 50 по 
подразбиране, чрез което се задава приоритет на опроводяването на компонентите, 
принадлежащи на тази мрежа. 
- Поле Min Width – минимална широчина на писта. 
- Поле Conn Width – автоматичният трасировчик създава нови писти, като 
използва стойността от това поле. 
- Поле Max Width – максимална широчина на писта. 
- Бутон Net Layers – разрешава слоевете, на които може да бъде опроводена 
избраната мрежа (виж. Фиг. 5). 
- Бутон Width By Layer – позволява да се дефинират различни широчини на 
избраната мрежа за различни слоеве (виж. Фиг. 6). 
- Бутон Net Spacing – позволява да се промени разстоянието писта-писта за 
избран слой (виж. Фиг. 7). 



- Бутон Net Reconnection Type – дефиниране на правилата за преопроводяване 
(Фиг. 8): 
· Опция None – забранява на автоматичния трасировчик преопроводяване на всяка 
връзка, от точка до точка на избраната мрежа. Използва се при критични мрежи, 
които трябва да бъдат опроводени в определена последователност. Мрежите се 
опроводяват в реда на тяхното появяване в Netlist файла. 
· Опция Horizontal – автоматичният трасировчик първоначално търси 
хоризонтални пътища за всяка връзка в мрежата. Използва се за опроводяване на 
захранване и земя. 
· Опция Vertical – автоматичният трасировчик първоначално търси вертикални 
пътища за всяка връзка в мрежата. Използва се за опроводяване на захранване и 
земя. 
· Опция Std Orthog – автоматичният трасировчик търси най-лесния и най-
оптималния път между две точки в мрежата. Това правило е по подразбиране и би 
трябвало да се използва при опроводяване на стандартни цифрови сигнали. 
· Опция High Speed – забранява Т-връзките и автоматичният трасировчик 
използва верижни връзки (Daisy-chain connection); 
· Опция No Dyn Reconn – забранява динамичното преопроводяване  
   Динамично преопроводяване (Dynamic Reconnection)– метод за изчисляване 
на местоположението на най-близкия извод на същата мрежа и на преначертаване 
на мрежата от връзки, за да се реализира връзка с най-близкия извод. Опцията 
забранява динамичното преопроводяване и като резултат не се изчаква 
преизчисление и преначертаване на ratsnest. Изключително полезно при 
опроводяване на големи мрежи. 

 

Фиг. 5. Диалогов прозорец за разрешаване на слоеве за проводяване 

 

Фиг. 6. Диалогов прозорец за дефиниране на широчина на писти на слоевете 



 

Фиг. 7. Диалогов прозорец за дефиниране на разстоянията за отделните  слоеве 

 

Фиг. 8. Диалогов прозорец за дефиниране на правилата за преопроводяване 

2.3.4. Процедура за опроводяване на мрежите захранване и земя 

Стъпка 1. Разрешаване на мрежите захранване и земя за опроводяване и  
забраняване на останалите мрежи 

Алгоритъм за разрешаване на мрежа „захранване”: 

- Избор на електронната таблица Spreadsheet Toolbar button => Nets или 
Tool  => Nets  => Select from spreadsheet; 

- Избор на колоната Routing Enabled от електронната таблица на мрежите и двоен 
клик на ляв бутон на мишката върху нея; 
- В диалоговия прозорец Edit Net се отменя опцията Routing Enabled, като всички 
мрежи се забраняват за опроводяване; 
- Натискане на бутон TAB и се отваря диалоговият прозорец Net Selection Criteria; 
- Избор на мрежа VCC и команда от pop-up меню Properties (или двоен клик на ляв 
бутон на мишката); 
- В диалоговия прозорец Edit Net се избира опцията Routing Enabled за мрежа VCC; 
- Избор на Бутон Net Layers 
- В диалоговия прозорец Layers Enabled for Routing се избира слой Power в полето 
Plane Layer; 

Алгоритъм за разрешаване на мрежа „земя”: 

- Избор на електронната таблица Spreadsheet Toolbar button => Nets или 
Tool  => Nets  => Select from spreadsheet; 

- Избор на колоната Routing Enabled от електронната таблица на мрежите и двоен 
клик на ляв бутон на мишката върху нея; 
- В диалоговия прозорец Edit Net се отменя опцията Routing Enabled, като всички 
мрежи се забраняват за опроводяване; 
- Натискане на бутон TAB и се отваря диалоговият прозорец Net Selection Criteria; 
- Избор на мрежа GND и команда от pop-up меню Properties (или двоен клик на ляв 
бутон на мишката); 
- В диалоговия прозорец Edit Net се избира опцията Routing Enabled за мрежа GND; 
- Избор на Бутон Net Layers 



- В диалоговия прозорец Layers Enabled for Routing се избира слой Ground в 
полето Plane Layer. 

Стъпка 2. Реализиране на процеса Fanout за схеми с повърхностен монтаж (точка 2.3.2) 

Изпълнява се при многослойни платки с повърхностен или смесен монтаж. 

Стъпка 3. Проверка на опроводяването на захранващите слоеве 

Алгоритъм за проверка 
- Избор на електронната таблица Spreadsheet Toolbar button => Statistics или 

View => Database Spreadsheets  => Statistics 
- Проверка на реда % Routed -  трябва да бъде 100%; 

Стъпка 4. Забраняване на мрежите захранване и земя за опроводяване и  
разрешаване на останалите мрежи 

Алгоритъм за разрешаване на останалите мрежи 
- Избор на електронната таблица Spreadsheet Toolbar button => Nets или 

Tool  => Nets  => Select from spreadsheet; 
- Избор на колоната Routing Enabled от електронната таблица на мрежите и двоен 
клик на ляв бутон на мишката върху нея; 
- Избор на команда от pop-up меню Enable-Disable, като всички мрежи се 
разрешават за опроводяване и имат флаг Yes, а опроводените вече мрежи за 
захранване и земя са с флаг No*; 
- Когато към флага има символ * ( Yes*, No*) това означава, че съответната мрежа 
има специални дефиниции за слоевете (например, че мрежата е присъединена към 
plane слой). 

2.3.5. Създаване на разделени плоскостни слоеве 

(Creating split planes) 
Особености: 

- Присвояване на вторична мрежа към плоскостен слой става чрез създаване на медна 
зона “copper pour”; 
- Първичната (основната) мрежа се присъединява към plane слоя, а вторичната мрежа 
към медната зона; 
- Плоскостните слоевете са с негативно изображение, така че на екрана се изобразява 
изолацията. 

Алгоритъм за разделяне на плоскостен слой 

- Избор на електронната таблица Spreadsheet Toolbar button => Nets или 
Tool  => Nets  => Select from spreadsheet; 

- В електронната таблица на мрежите избор на първичната мрежа  и на pop-up меню 
=>Properties; 
- В диалоговия прозорец Edit net се избира бутон Net Layer; 
- В диалоговия прозорец Layers Enabled for Routing от поле Plane Layers се избира 
слоят, към който ще бъде  присъединена първичната мрежа; 
- Поставят се на съответния plane слой петна от тип Thermal relief, които съответстват 
на петната за нормален монтаж и проходните отвори за първичната мрежа. Thermal 
relief петната са с цвета на тази мрежа.  
- Промяна на цвета на първичната мрежа, като се избере мрежата от електронната 
таблица и на pop-up меню се изпълни команда  Change Color; 
- Промяна на цвета на вторичната, като се избере мрежата от електронната таблица и 
на pop-up меню се изпълни команда  Change Color; 
- Избор на команда View=>Zoom DRC\Route Box – увеличаване на областта, където 
ще се прави медната зона; 
- Избор на Obstacle Toolbar button => New или команда 

Tool  => Obstacle  => New; 
- Избор на команда от pop-up меню Properties 



- В диалоговия прозорец Edit Obstacle се дефинират параметрите на зоната, като 
се попълват следните полета (Фиг. 9): 

 Поле Obstacle Type  – избира се Copper pour; 
 Поле Obstacle Layer - избира се съответния слой; 
 Поле Net Attachment – избира се вторичната мрежа, която се присвоява 

към медната зона. 
- Изчертаване на областта на медната зона, която трябва да включва поне един 
извод от вторичната мрежа; 
- Избор на Refresh All toolbar button за обновяване на изображението. 

 

Фиг. 9. Диалогов прозорец за дефиниране на очертание за медната зона в плоскостен слой 
 

На Фиг. 10 е показан пример за разделяне на плоскостен слой „земя” на една първична мрежа 
GND (син цвят на thermal reliefs), и две медни зони, присъединени към две вторични мрежи, 
съответно AGND (розов цвят на thermal reliefs) и GND EARTH (зелен цвят на thermal reliefs). 

2.3.5. Ръчно опроводяване на сигналните мрежи 

Алгоритъм за опроводяване на връзка от точка до точка 
- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 

Add/Edit Routе Mode toolbar бутон;  
- Избор на петно за начало на опроводяването на мрежата; 
- Клик на ляв бутон на мишката за поставяне на логическа точка (vertex); 



- Избор команда от Pop-up=>Finish  - за край на пистата; 
- Избор команда от Pop-up и End Command – за излизане от режима. 

Алгоритъм за опроводяване на писта със закръглени краища 
- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 

Add/Edit Routе Mode toolbar бутон;  
- Избор на петно за начало на опроводяването на мрежата; 
- Избор команда от Pop-up=>Curve Corners  - за прекарване на писта със закръглени 
краища; 
- Клик на ляв бутон на мишката за поставяне на логическа точка (vertex); 
- Избор команда от Pop-up => Finish  - за край на пистата; 
- Избор команда от Pop-up и End Command – за излизане от режима. 

 

Фиг.10. Разделяне на плоскостен слой „земя” и дефиниране на две медни зони 

Алгоритъм за промяна на широчината на писта в процеса на опроводяване 

- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 
Add/Edit Routе Mode toolbar бутон;  

- Избор на петно за начало на опроводяването на мрежата; 
- Клик на ляв бутон на мишката за поставяне на логическа точка (Vertex); 
- Избор команда от Pop-up => Change Width – за промяна на широчината на писта 
(Фиг.11); 
- Избор команда от Pop-up => Finish  - за край на пистата; 
- Избор команда от Pop-up и End Command – за излизане от режима. 

Алгоритъм за промяна на широчината на опроводена писта  

- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 



Add/Edit Routе Mode toolbar бутон;  
- Маркиране на опроводената писта; 
- Избор команда от Pop-up=> Change Width – за промяна на широчината на писта 
(Фиг.11) 
- Избор команда от Pop-up=> Finish  - за край на пистата; 
- Избор команда от Pop-up и End Command – за излизане от режима 

Алгоритъм за заключване на писта 

- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 
Add/Edit Routе Mode toolbar бутон;  

- Маркиране на опроводената писта; 
- Избор на команда от pop-up меню Lock/Unlock за заключване на пистата.  
- Командата предотвратява избутването, местенето или разкъсването на пистата от 
автоматичния трасировчик. 

 

   
 

Фиг. 11. Команда Change Width за промяна на широчината на писта 

Алгоритъм за премахване на опроводяването 

- Избор команда за ръчно опроводяване  Tool=>Track=>Select Tool или 
Add/Edit Routе Mode toolbar бутон;  

- Маркиране на опроводената писта; 
- Избор на команда от pop-up меню Unroute segment  - за изтриване на сегмент от 
писта; 
- Избор на команда от pop-up меню Unroute Net  - за изтриване на мрежа; 
- Избор на команда от pop-up меню Unroute   - за изтриване на писта (Фиг. 12); 

 

 

Фиг. 12. Команди за премахване на опровадяването 

3. Средства и режими за опроводяване  
3.1. Команда за конфигуриране 

Orcad Layout поддържа три групи средства за опроводяване. Диалоговият прозорец на 
командата  Option=>Route Settings е показан на  Фиг. 13. Бързите бутони, съответстващи на 
тези средства, от лентата с инструменти са показани на Фиг. 14. 

Команда: Option=>Route Settings 

3.2. Режими на опроводяване  
Поле: Route mode 

- Четири режима, два за ръчно и два за автоматично опроводяване: 
· Add/Edit route mode – ръчен режим за единични връзки, без избутване, 
възможност за включване и изключване на системата за проверка на грешки DRC; 



· Edit Segment Mode – ръчен режим за работа за редактиране на сегмент на писта; 
· Shove track mode – автоматичен режим. Автоматично мести или избутва писти за 
освобождаване на място за връзката, която се опроводява. Трябва да бъде включено 
DRC. 
· Auto Path Route Mode – автоматичен режим. Показва пътя на възможната писта, 
слоя, на който би се извършило опроводяването и прави предложение за проходни 
отвори (Опция: Suggest Vias). 

3.3. Средства за конфигурация на ръчното опроводяване 

Manual Route Settings 
В този режим се установяват конфигурационните параметри на ръчното опроводяване. 

Опция Snap to Grid Routing – опроводява се по точките на мрежата за опроводяване; 

Опция Drawing Method – указва се ъгълът, под който да се поставят логическите точки на 
пистите. 

3.4. Средства за конфигурация на интерактивното опроводяване 

Interactive Auto Route Settings 
В този режим се установяват конфигурационните параметри на интерактивното 

опроводяване. 

 

Фиг. 13. Конфигуриране на средствата за опроводяване 

 



 
Фиг. 14. Бързи бутони за средствата за опроводяване 

4. Проверка на опроводяването 
4.1. Проверкa за нарушения на разстоянията при опроводяване 

(Routing Spacing Violations) 

Алгоритъм за проверка на разстоянията при опроводяване 

- Избор на команда Auto => Design Rule Check ; 
- В диалоговия прозорец    избор на бутон Clear All (Фиг. 15); 
- Избор на опция Routе Spacing Violations; 

DRC процесът в Layout проверява платката и маркира грешките с кръгове. 

 

Фиг. 21. Диалогов прозорец за проверка на грешки при разполагане 

4.2. Проверка на статистиката за опроводяване 

Опроводяването на платката се проверява чрез извеждане на статистика на разполагането, 
която е показана на Фиг. 22. 
Алгоритъм 

- Команда за извеждане на View => Database Spreadsheets => Statistics или  
      Spreadsheet toolbar button =>Statistics; 



- Показва се елетронната таблица за статистиката; 

Търсят се редовете за опроводяване на платката -  %Routed  Row 

 
Фиг. 22.  Статистика на опроводяването 


